
Win1010 Contest Program Overview
The K4HAV Win1010 Contest Program is the 2nd version of the DOS-based K4HAV 1010 Contest Program used by
many 1010 Contest Operators since it was first introduced in 1990. Since this program was written to be a Windows
95/98 application, it overcomes the memory limitations that the earlier DOS-based program had. Win1010 allows for
more QSO’s, bigger databases, better screen displays, improved printer support and more bells and whistles. The DOS
based contest program consisted of 26 individual programs, each designed for a single function. This was required to
overcome the DOS memory limitations. Win1010 has all functions and options in a single program. After using Win1010
during one contest you will never go back to the old way of hand logging. Win1010 has so many options and features
that you will probably not use them all, but they are there if you need them. Many of the features are a result of sugges-
tions by users.

Demo Mode
The full Win1010 Program is available for download from the Hardy Data Systems web site at http://hds.net. Without a
customized UserID file, Win1010 operates in the Demo Mode. This mode limits the number of QSO’s to 25. The
UserID file will be emailed or mailed upon receipt of the upgrade or purchase price. The log and dupesheet printer will
only print the first 25 QSO’s, but all the Database Utilities have no record limit.

Help Files
These Help Files can be printed by going to the Help “File” Menu and choosing Print Topic. Bookmarks can be added
from the Bookmark menu.

Support for the K4HAV 1010 County Hunter Program
The Win1010 Contest Program has several export options that will allow the Win1010 contest logs to be exported into
the K4HAV Win1010CH County Hunter Program which is an add-on module to the Win1010 Contest Program. The
Win1010CH program has a file named CoIndex.DAT that keeps an index of the worked counties. If the “County Input
Option” and the “Check new 10X, VP and County Option” in the Win1010 Program is activated, if a new county is
worked a red box will appear indicating “New County” – likewise for “New 10X” or “New VP”. A Contest log can
also be exported into the Daily Log.

Win1010CH Add-on Module
This module can be accessed by clicking on the “County Hunter” tab at the top of the screen. Without the County
Hunter UserId file, the program operates in the Demo mode and allows up to 25 QSO’s to be entered into the log.
However, if you have a Win1010 Contest Log, it can be imported and displayed. During Contest operation, you can
switch between the three programs by hitting the Exit on the Certificate Chaser, County Hunter or Daily Log box to
return to the Contest and then hit the Certificate Chaser, County Hunter or Daily Log tab at the top to return to those
other programs..

Win1010 Daily Log Module
This module can be accessed by clicking on the “Daily Log” and info about this module can be read in the Log Help
under the Help Menu. Contest log export to the Daily Log is also provided.

Win1010 Features
Win1010 is designed for the 1010 contester. It includes several databases: the 1010 Database which has all the as-
signed 10X numbers and calls, the VP database with all the VP numbers and the Contest Database, which is a database
of active contesters. Many users have sent their logs to the author and they have been combined into a large database.
Most of the stations contacted during a contest will already be in the database and their info will be entered in the log
automatically ready for you to confirm.

In addition to the built-in databases, Win1010 accesses the BuckMaster, QRZ, and Amateur Radio Flying Horse CDs



as well as XXIP and the K4HAV FCC Database. The FCC Database can be downloaded from the Internet. This
database is updated weekly and would provide the most current callsign and address info. All the built-in databases can
be updated on the Hardy Data Systems web page at http://hds.net/win1010dl.htm.

Win1010 will print your logs and dupesheets in various formats. Logs can be exported in various formats and imported
into the K4HAV Win1010CH County Hunter Program. After the contest is over you can have your logs and dupesheets
printed in a few minutes.

Win1010 utilizes your computer’s sound card to provide some useful sound features. You can record voice messages
and play into your transceiver. Let your computer call CQ for you and give the other station your information. A Func-
tion key can be hit and your computer will record an off-the-air message or your computer can be setup to provide a
continuous loop of recordings. If you miss a call, just hit replay and the previous minute (or any user set time period) will
be replayed.

Win1010 can be used by an operator using both his station and a club station. A second log can be created for the
second station and selective QSO’s added to this log by hitting the F4 key. The second log will have the same name as
the contest log with a “2” added to the end of the name. This 2nd log can be viewed full screen by an option in the
VIEW Menu. This same procedure can be used by an OM/XYL team. Later to print the logs, the 2nd Contest Log
would have to be loaded into the program. For more details on using the second log feature see the 2nd Log section
later in the help file.

Monitor Screen Resolution
This program uses a re-sizing control that will display the program full screen no matter what screen resolution you have
your monitor set. However, the resolution that many computers use - 640x480 - will have the largest display fonts and it
will be hard to display the screens with a lot of data and displays. It is recommended that you run your screen resolution
at 800x600 or 1024x768. At 640x480 only the last 8 QSO’s will be shown in the QSO Log Window, whereas at
800x600 the last 11 will be displayed. At 1024x768 the last 16 QSO’s will be displayed, and at 1152x864 the last 18
will be displayed. I prefer the 1024x768 resolution using Small Fonts. The Win1010 Program was developed using
Small Fonts as the default  On monitors using Large Fonts, some of the text in the various boxes may get cropped or
wrapped.

There is a routine that will pop-up a window if you are running 640x480 and suggest that you change your screen
resolution to 800x600 or higher. Also on the message window upon start-up will be a message stating what resolution
you are using. This window will also state whether you are using Small or Large Display Fonts. To change resolutions
and/or size of screen fonts, you can right click on a blank place on the windows desktop and choose Properties, then
choose Settings and change your resolution. Most new computers will allow you to change the screen resolution without
rebooting. You can usually change to small fonts by using the “Advanced” tab setting.

Before running the program, it is recommended that you hide the Task Bar by going to Start, Settings, Task Bar and
clicking “Auto Hide”. This will give a larger screen display by using the entire screen.

Starting a Contest – Option Menu
Before starting a contest several things need to be configured and setup. Many of these items will become your defaults
saved in the win1010.cfg file, but can be changed later if desired. The configuration and setup is on the Options Menu.
This Option Menu can be moved on the screen or resized. However, if down-sized, some of the text may wrap and all
the text may not be visible. Also there are additional HELP screens on various individual displays that can be used for
fast HELP. For some reason, if you have a new computer and no printer installed, you will get an error when trying to
access the Option Menu.



1. Contest Setup: This is on the Options Menu located on the menu bar at the top of the display.

a. GMT Offset. The computer will display the GMT time on the display as well as entering the correct GMT time
and date in the log. By using this technique you will not have to change or reset the time and date on your
computer. Should you need to change your time or date, you can hit Ctrl-T or double-click on the GMT label
on the clock. This will pop-up a window to change first the time, then the date. The change will take effect upon
the first entry to the Call input field.

b. Choose Default Contest Database and Address Database. This choice is needed if you plan to automati-
cally check these databases on each contact. There is a checkbox to check if you want this option. For ex-
ample, if you have chosen as default the DB95.DAT Contest Database and checked the checkbox to automati-
cally check the contest database on each contact, then after you type in the call and hit enter this database will
be searched and if found, the info will be entered in the appropriate contest QSO entry fields. This will happen
very fast. However, if the checkbox is checked on the “Automatically Check Default Address Database on
every contact”, then there will be a slight delay while this database is accessed, especially if it is one of the
databases on CD-ROM. If you have more than one address database installed, you can access it by clicking on
the red button at the bottom of the screen that corresponds to that database or use the ALT-Combination
shortcut key.

c. County Input Mode Check Box. This is for the County Hunter. If this check box is checked then after the
state has been typed in, the upper left display box will have the counties displayed for that state. You can scroll
down and pick out the correct county. A short cut would be to type in the first letter of the county and the
display will jump down to the first county beginning with that letter. Then scroll down to the correct county and
hit ENTER to file this county. This county will then be filed with the QSO for later use. If you did not get the
County, then you can hit the ZERO number and the County field will be left blank. The 1010CH program has a
file named CoIndex.DAT that keeps an index of the worked counties. If the County Input Option in the
Win1010 Program and the Check New 10X, VP and County are activated and a new county is worked a red
box will appear indicating a “New County”.

d. Post Contest Mode. This would be checked only if you wanted to enter info for a contest after the contest.
This mode will allow you to enter the time and date for each QSO. During a regular contest the computer will
enter the correct GMT time and date. If this option is enabled, you will need to enter the correct date for the log
in a popup box in the format MM/DD/YYYY in the Options routine after you click on this option. After filing
the QSO, there will be a pop-up window for you top enter the time of the QSO. During a two day contest, the
date will only have to be changed twice. To change the date, just run the Options Menu again. There is a trap to
alert the user if the time just entered is earlier than the preceeding time. This would be the case for a mistaken
time or a change in dates. This mode can also be used for entering contacts from other sources than a contest.
After entering the contacts, they can then be exported to the County Hunter or Daily Log using the Contest
Export Menu. The Control-S key will sort this type log by time and date.

e. Automatically Check Default Address Database. If checked, and path to Database is installed, will display
database info in message window after the Call is entered into the Call field and ENTER is hit.

f. Automatically Check Default Contest Database. If checked, will search database and put info in proper
QSO fields after the Call is entered into the Call field and ENTER is hit. This info should be confirmed over the
air.

g. DX User Mode. This is used only for non-U.S. operators. If you are a VE or other DX operator, then you will
also have to set up the various prefixes for your country, so that the 3 point scoring routine will be correct. This
setup is on the MISC page of the Options Menu. Additional instructions for this setup is on that page.



h. Disable Dupe Checking. This would be used if you wanted to use the Win1010 Contest Program as a daily
log and you wanted to log all stations, even if they had been worked before. For daily logging purposes, the
County Hunter Program would be a much better choice. There is a 3000 QSO limit, but the daily log could be
named Daily98.Q95 for the 1998 QSO’s and Daily99.Q95 for the 1999 QSO’s.

i. Disable New County, New 10X and New VP Flags from County Hunter Files. If the County Hunter data
files are present, they will be checked for new 10X, VP or County. This checkbox will disable this routine.

j. Disable F4 Key. One user reported that he had “fat fingers” and sometimes while hitting the F5 key to play a
CQ, he would hit the F4 Key first. This option just disables the F4 Key. This is not saved to the Config File,
therefore, it would have to be disabled if re-running Win1010.

k. Enable QSO by QSO Printout. This will send each QSO as it is filed to a printer. However, Windows won’t
print line-by-line, only a full page at a time. You can force a printout by hitting the Ctrl-F Key which will make
the printer print and page eject. This option is not written to the Config file.

l. Auto Insert County From FCC Database. If checked this will take the County info from the FCC Database
search and insert the County into the County field. This can be done manually by clicking on the red FCC
Button, or automatically by enabling the automatic FCC Database search in paragraph e. described above.
This county is derived from the Zip Code and may be wrong in some cases. Some times the Zip Code covers
parts of two counties; therefore, this inserted County must be confirmed over the air. The County can be edited
by hitting Ctrl-C which pops up the County Selection Window.

m. Disable Beeps During Contest Operation. If checked this will turn off the warning beeps during the contest
operation. This would be needed for those using the Computer Sound Card as a voice keyer. The beeps may
trigger the VOX and cause an on-the-air transmission. This option is NOT saved to the config file and will have
to be reset whenever the Win1010 program is restarted.

2. Change Colors. Most of the colors can be changed from this option page. If you want to see the result of a
different color then you can hit the APPLY button (or ALT-A key). If you want to save these colors to your configu-
ration file then you can hit SAVE to write the new colors to your configuration file. At any time you can always
return to the default settings by hitting the DEFAULT button.

3. Set Database Paths. This allows the user to enter his own paths to the various databases. If the “Installed” check
boxes are not checked then that database will not be accessible to the program. The default paths will be correct in
many cases. Many users may already have the K4HAV FCC Database Program installed. If so, then these files can
remain in the same directory and the path entered. It is assumed that the Zip Code files will be in the same directory
as the FCC data. These files could also be placed within the Win1010 directory if desired.

4. Misc Page. Set your azimuth on this page. This setting is used to calculate the distance and heading to the DX
station and also with the FCC Database. These values are included in the UserID file but can be changed by using
this option. The user’s call, name, and other info are written into the UserID file; however, there is an option on this
Misc Page to modify the street address, location and callsign. Also on this page is an option to enable the automatic
contest file backup to a floppy disk in Drive A after “X” number of QSO’s. This is option choice is not written to the
config file and must be made at the start of each session. Since this is a multi-purpose program, it may be possible
that you may want the program to start in the County Hunter or Daily Log Mode instead of the Contest Mode.
There is an option choice of the start-up mode, which will take effect the next time the program is run. A new feature
is a method of saving the column positions on the Contest Log and County Hunter Log windows. These values are
saved in a Column Spacing configuration file and will take effect the next time the program is run.



VP Insert on County Hunter Menu: There is an option on the County Hunter Options Menu that also applies to the
Contest Program. If you have a VP number, then by checking the “Enable Automatic Insertion of VP Number”, the
VP number will be taken from the VP Database and inserted into the Contest Program log. A valid VP QSO will be
made if both parties have a VP number. If you do not have a VP number then you should not check this check box.

There is a special hot key - Control-N that when hit, will bypass the VP field during contest operation. This is not saved
to the config file and must be hit each time the Contest Program is started. This might be used by someone not having a
VP number or by a big-gun contester that needs to save every keystroke. After all the options have been set up, then
you will need to choose a contest name. To do this, click on File and choose “New Contest”. The familiar Window’s
Open File window will pop up and display the existing contest file names. Choose a file name that does not exist. Now
you are ready to begin the contest. If you are resuming a contest, then use the “Open Existing Contest” instead.

PLEASE NOTE: The default Windows folder is “My Documents” – this should be changed to the Win1010 Folder
BEFORE opening the first contest file. Once this is changed, then the Win1010 folder will be remembered. Opening a
New Contest File in the “My Documents” will change the default Win1010 folder. None of the other modules will run
correctly unless the program is restarted. There is a popup message window to remind you to do this.

Contest Operation
The home position for the cursor is in the Callsign field. At most times you can return there by hitting the blue “K” button
(Kill) at the bottom right of the screen display. The main purpose of the “K” is to Kill the QSO info that is entered but
not yet filed. Maybe it was a dupe or you just could not finish the QSO and you want to delete it.  Hitting the ESCAPE
key does the same thing. The original DOS version of the 1010 Contest Program used the Ctrl-K key to kill the QSO
and this can also be used in this Windows version to offer continuity between the two programs. Old habits are hard to
die. In this Windows version you can hit ALT-K, Ctrl-K, the ESCAPE key or the Blue K button to accomplish the
same thing. You can also use the mouse to place the cursor in any field you wish. Take your choice.

Move between QSO entry fields by hitting the ENTER key. The TAB key (or Shift-TAB for reverse) can also be used
to move between fields; however, the ENTER key should be used because it triggers several “KeyPress” events.
Another method to move between fields is the Ctrl-Left Arrow and Ctrl-Right Arrow keys. For DX stations, after the
name is entered, the name of the country will automatically be entered, assuming that the prefix is in the DX Country
database (CTY_AZ95.TXT). The distance and beam bearing to the DX country will be calculated and displayed in the
Message Window. This DX database can be edited by the user to add new prefixes. If the country name is not entered
by the computer then the user can manually enter it. After the 10X number is entered, the VP database is checked and
the VP number is entered if the station has one in the VP Database. If you collect VP numbers, this VP number should
be confirmed over the air. Hitting ENTER at the VP number field will file the QSO. Hitting the F1 Key will also file the
QSO. This may be more convenient if the cursor is not at the VP field.

Introduced with Version 2.0a, there is a Multiple Country Selection menu for the prefixes that can be used for more than
one country. At the current time, the prefixes are 3D2, 3Y, CE0, CY0, FO0, FR, FT, HK0, JD1, KH5, OH0, PY0,
SV, VE1, VK9, VK0, VP8, VU, VU7, and ZK1. If a call is entered that begins with one of the above prefixes, then
the popup window will give you a choice of the countries that the prefix can represent. This routine is also used in
exporting contest files into the County Hunter and Daily Logs, as well in those two programs. These prefixes are written
into the Win1010 program code and cannot be edited by the user.

Call Field. Enter here either the Call or the 10X number. If the 10X number is entered, then it is converted to a call, the
default Contest Database searched and the info put into the proper fields. Many times during a contest you may hear a
station just giving his 10X number. A portable station in a DX country should be entered as VK3/K4HAV.  In this case
the Contest Database will be searched for K4HAV and the info inserted. Since the QTH will be the name in the Data-
base, you will need to click the mouse in the QTH field for the automatic DX country routine to determine the country.



Or you can use the Ctrl-Left Arrow key to return to the QTH field to activate the DX Country name routine. The DX
prefix must also be at the beginning for the automatic DX Country insertion to be activated. For example: KP4/K4HAV
would have the QTH entered as Puerto Rico.  For Mobile stations, the call entry should be K4HAV/M or K4HAV/M7.
The database will again be searched for K4HAV and the info inserted. If the county is different, Ctrl-C will pop-up the
County Selection windows. Double-click on the desired county and it will be inserted into the County field. As stated
above after the call is entered, the Default Contest Database is searched and if the call is found, then the database info is
entered into the various fields. However, if the call is not found, then the 1010.TXT database file is checked and if the
station has a 10X number, it is entered into the 10X field for your confirmation.

Edit QSO. The QSO can be edited after the QSO is filed by double-clicking on the desired QSO to edit. A window
will pop-up displaying the current log info. Use the TAB key or mouse to move between fields and make the necessary
changes, then hit SAVE to file the changes. After returning to the main display screen the results of this edit will not be
shown unless the red REF (Refresh) button is clicked. This will refresh or update the log display. Version 1.1 added the
pop-up County Selection window to edit the County. The state field has to have a valid state abbreviation for this
window to appear. Double-click on the desired County and it will be placed in the County field and the County Number
placed in that field. Only the County Number is stored in the QSO file.

Delete a QSO. A QSO can be deleted by editing the QSO in the QSO Log Window by double-clicking on the QSO.
Then click on the Delete button. The Callsign will be changed to “Deleted”. The score will be modified to reflect this
deletion. Before the logs are printed you will need to run the “Remove Deleted QSO’s From Log” routine in the Contest
Utility Menu. If you forget to run this routine and if a deleted QSO which will be marked “Deleted” is found by the log
printer, it will be by-passed. It is suggested that if you do delete QSO’s then you run the “Remove” routine.

QSO Log Window. The log window box will not display all the fields if the user is using a 640 x 480 screen display.
There is a horizontal drag bar which can be moved to the right to display the other fields. You can also change the width
of the columns by dragging the heading titles. Or the column widths can be set and saved in the Options Misc Menu.  It
is recommended that the screen resolution be set to 800 x 600 or even higher. The main screen has a resize feature
meaning that if the window is resized that all the controls, boxes and fonts will also be resized. The default display is full
screen. If all the fields won’t fit on the screen, a horizontal slide bar will appear. If the headings are moved to allow all
the fields to be displayed, then this slide bar will disappear. On a new contest the right vertical slide bar doesn’t appear
until the QSO totals reach a certain level. At that time the bottom QSO may be partially hid, but the display will be back
normal at the next QSO. At any time the red Refresh (REF) button can be hit to refresh the screen and add the side
slide bar if there are more QSO’s than will fit in the window. If using a 1078x768 and/or higher screen resolution, you
should adjust the headings so that the horizontal bar disappears. That will allow for the last 16 or more QSO’s to be
displayed.

Check Contest Database. If the “Check Contest Database” option is ON, after typing in the call and hitting ENTER,
the computer will check the database and if found, the results will be automatically entered in the correct fields. Also if
there is a VP number in the VP database, it will also be displayed for you to confirm over the air. Hitting ENTER then
will file the QSO. Since  this contest database is a combination of many different user logs, the accuracy may not be 100
percent; therefore, you should use this database with the understanding that it is up to you - the user - to use this as a
guide and make any corrections needed. As mentioned above, you can edit a filed QSO by double-clicking on the
QSO in the log window. Version 1.1 adds the insertion of the County from the FCC Database if this option is setup in
the “Contest Setup Page” of the Options Menu.

QSO Checking. There are several info checking routines that happens when the QSO is filed. The Call, Name, QTH
fields are checked and if any are blank then a warning message box will pop up indicating the blank field and the cursor
will return to that field after the message box is cancelled. Also the 1010 database is checked to make sure the 10X
entered matches the callsign. If not a pop-up message box warns of a potential error and gives the call that matches the
10X number. If either the call or 10X is wrong, then it can be edited in the log window. You may get this warning



message if the station has recently upgraded his call and it is not in the 1010 database yet. For this routine to be accu-
rate, the user needs to be using the most-current update of the 1010 and VP databases. These files can always be
downloaded from the Hardy Data Systems web page at http://hds.net. Another info checking routine is the Silent Key
checker. If the 10X number in the log belongs to a Silent Key then a warning message box will pop-up. For this routine,
only the 10X number is checked because a Silent Key’s call may be re-issued as a vanity call.

Automatic Dupe Checking. After the callsign is entered the log is checked for dupes. If the call is a dupe, then a
message box displays the warning and the info for the station. Hitting ENTER or ESCAPE will kill the QSO and return
the cursor to a blank Callsign field. After the 10X number is entered it is checked for dupes also and a message box
pops up if it is a dupe. Likewise hitting ENTER or ESCAPE will kill the QSO and clear all fields. This can be turned off
by a check button in the Options “Contest Setup”. You could do this if you wanted to use Win1010 as a daily log;
however, the County Hunter Program would serve much better as a daily 1010 log.

Rate and Score Box. This box displays the contest rate for the last 10 QSO’s, the rate for the last hour, and the
overall contest rate. Also displayed is the total operating time. The total time will allow for off times if you exit the
program. If you exit the program, say an hour after the last contact is made, then the time for the last contact will be
used as the sign-off time. Therefore, the total time will always be less than the exact total time unless you log off just
after the last contact is made. The running total time is entered into each QSO record. The Contest Score is updated
after each QSO. After the Total Time passes 24:00 it will start over and the Label will change to Time+24H.

Rate Graph. The VIEW Menu has an option that will display a rate graph showing contacts per hour for each day. The
first day will be red bars and the second day will be green bars. This display is very impressive when viewed after the
contest is over. Exit this display by clicking the “X” in the upper right hand corner. This display is full screen by default,
but can be resized if desired. The screen title will have the total number of QSO’s and each day’s total. The display is
valid only for two consecutive dates as would be the case in a contest.

Rate Window. If you hit Ctrl-Q a Help Topic Window will be displayed showing the number of QSO’s per hour for
Day 1 and Day 2. At the end of the display will be a recap of the 1, 2 and 3 point QSO’s.

GMT Time. The GMT time is displayed in a window and the computer time can be changed by double-clicking on the
time on the lower right side of the screen on the task bar. The built-in Windows 95/98 time and date change routine will
pop up.

Sound Card Features. Hitting any of the Functions Keys (F5 thru F12) will play a pre-recorded message. The F-Key
help topic file can be edited to reflect your personal message titles. You will want a short CQ, a long CQ, a long CQ
pleading for contacts when things get slow, an info message, a QSL and QRZ message and any others that might be
needed during a contest. For more info on setting up this sound feature see the separate section on this later.

New County Indicator. If you are a K4HAV Win1010CH County Hunter Program user, the program will check the
CoIndex.DAT file and if the QSO is in a new county, then you will hear a beep and the label on the County field will be
replaced with a red box indicating “New County”. Since the Win1010 Contest Program does not modify the CoIndex
file, you will get this indicator every time you work a station in the same new county. Likewise, if a new 10X or VP is
worked a similar red flag will be displayed.

Make QSO Log Backup. Hitting Ctrl-B will make a backup on floppy drive A. Also typing SAVEA as a callsign will
trigger a backup. An automatic backup can also be made by setting up on the MISC Menu of the Options. SAVEA
was used in the DOS-based 1010 Contest Program.

Exit Program. There are four ways to exit the program. Clicking on the Blue Exit Button, hitting ALT-E or clicking on



the Exit under the File Menu will exit with a Confirm Exit Message Box giving you a chance to change your mind. Hitting
the “X” in the upper right hand corner of the screen is a direct exit without a chance to change your mind.

Contest Aids
1. 10X, VP and Call Search. If you are tuning the band and hear someone just give his 10X or VP number you can

hit the red 10X button and enter either the 10X or Callsign and the complete database info for that station will be
displayed. This routine can also be accessed by hitting ALT-1. Likewise to search a VP number click on the red VP
button or hit ALT-V. The 10X and Call Search input box will remain on the screen until the ESCAPE key is hit. The
red VP button has been enhanced to do two functions. If there is a call in the Call field, then clicking on the VP
button will display the VP and 10X numbers in the small display box. If the Call field is blank, then an input box will
popup for you to insert the VP number and then the call and other info will be displayed. Ctrl-W: The normal red
button “10X” will check the database for the 10X number for a call that is inserted. This routine will only display the
first ‘Hit’ that it comes to. This assumes that each call will have only one 10X number. But this is not quite true.
Several stations have 10X numbers assigned to their calls for a club station. This Ctrl-W routine will search the
entire 1010 database and find the second 10X number. In the event that a 10X number has been assigned two or
three VP numbers, these duplicates VP’s will also be displayed. Also if the first 10X number for a call belongs to a
Silent Key and the new holder of the call also has a 10X then both will be shown as in the case of K6ZPW. The
original K6ZPW (now a SK) had 10X-91 whereas the present holder of the K6ZPW call has 10X-70183.

2. Partial Call Search. Type in the partial callsign in the callsign field and then hit the red PAR button (or ALT-P). The
upper left display window will display the calls & info matching in the Contest User Database. Scroll to the right or
double clicking on a call will display the 10X in the database. In the middle small display window will the calls
matching the partial call that is in the log. Again, double-clicking on the call will display the info.

3. Display Contest Database. Clicking on the red DB button (or ALT-D) will display the default Contest Database.
The database can be edited by double-clicking on the desired call or to display the 10X number you can just click
on the call and slightly move the mouse cursor downward and the 10X number will be displayed in the mouse tool-
tip window. The window can also be scrolled to the right and make the 10X number visible. You can add new calls
from the Database Utilities Menu.

4. Display WAS. Clicking the red WAS button (or ALT-W) will display the states needed for Contest WAS and also
the states already worked. Double-clicking on any state worked will then display every station worked in that state.
This red WAS button only works for the Contest Program.

5. Note Pad. Clicking the red NP button (or ALT-N) will pop-up a message window where a note can be written.
You can put Chapter info here or any other desired info. Hit F2 to file the note. There is a limit of 256 characters
per note. The note will be stored under the callsign. For example: If K4HAV is entered in the Call Field then the file
will be saved as k4hav.not in the Win1010\notes directory. These notes can be accessed later by clicking VIEW
menu heading and then choose “Notes”.  There will be a list of all the notes saved. Use the normal Windows edit
commands, such as Home to return to the beginning or End to go to the end. Should 256 characters not be enough
then the second note will be saved as k4hav2.not. Likewise the 3rd and 4th would be saved as k4hav3.not and
k4hav4.not.  Four notes per call should be more than adequate. However, you can always write a note and save it
to any word that is typed into the Call Field. For example: you could have a “mynote” or “mynote2” in the call field
and save a note to this Call (name).

6. County Display. Clicking the red CTY button (or ALT-T) will display a list of the States. Double-clicking a state
name will display the counties for that state. By clicking the mouse in the display, you can move to counties starting
with a letter by typing in that letter. Hitting Ctrl-C will also pop-up a County Selection window. Double-click on the
desired county and it will be placed in the County field.



7. Refresh Log Display. A feature of the log display is that you can sort any column by clicking on the heading name.
For example, if the user wanted to display all the stations worked in England you could sort on the QTH heading
and that column would be sorted in alphabetically order. Or if you wanted to find all stations that had the name of
Jim, you could sort on the Name column. The second click will sort the other way. After you are finished with this
sort routine, hitting the red REF button (or ALT-R) will refresh the log display in the logged order. Note: sorting on
the 10X column will not produce a true sorted list. This sort routine sorts column by column and since the 10X
numbers are not padded with zeroes all the ones in the first column is sorted first. This means that 10000 would be
sorted before 11, etc. If the columns are sorted, the screen must be Refreshed before one of the records is edited.

8. Checking Callsign Database. If any of the Callsign CD databases are installed in the Options Menu, any or all
can be accessed by typing a call into the callsign field and either clicking or hitting the hot key for the one desired.
The XXIP and FCC databases will be installed on the hard drive and can be accessed in the same manner. If using
XXIP, type a call in the call field and click on the red XXIP button and the info will be given. If the call field is blank,
you can type in a 10X number in the 10X field and click on the red XXIP button and the info will be given in the
small display window.

9. Checking Previous Callsign Database. If you want to find a new call for someone you know has got a new call
you can hit Ctrl-V (V for Vanity) and check for his new call. To use this option, the Prev_xx.DAT files must be in
the FCC Database path. These are files that are used with the K4HAV FCC Search Program and can be obtained
from a link on the hds.net web page.

10. Check Zip Code Database. If you want to check a Zip Code then hit Ctrl-Z and enter the Zip Code. The City,
State and County will be displayed. The Zip Code files must be in the FCC or the Win1010 directory.

11. Pop-up Calculator. A small calculator is activated by hitting the Control-A key combo.

12. Display Log Full Screen. This option is under the View Menu heading. You can adjust the size of the column
width by dragging the heading. Also clicking on the heading will sort that column. Clicking again will sort the other
way. You can edit a record by double-clicking on the record. A pop-up Edit Window will appear. Editing should not
be done after any column has been sorted. If you wish to edit after a sort, the exit the screen and re-display.

13. Display Date of Birth. Hit Ctrl-D for the DOB. The DOB_xx.TXT files or the single CallDOB.DAT must be in
the FCC directory with the path inserted in the Options Path Menu or the Win1010 directory for this routine to
work.

14. Print Running Log. One of the features of the DOS version of 1010 was the option to send each QSO as worked
to a printer. In case of a hard disk crash this would preserve the QSO data. There is an option on the Contest Setup
page to enable such a printout. However, Windows likes to print a full page at a time, so a line by line printout is not
possible. The page will print on these three events. (1) The page is full. (2) You exit the program. (3) Hit the Ctrl-F
key to Force a Form Feed.

15. Check Call or 10X in County Hunter File. Hitting Ctrl-H will pop-up a box for a call or 10X number and will
search the County Hunter data file (ch95.dat) and if found will display the info in the upper left screen. You may
want to know if you have worked a station before or the date and time.

Print Menu
The print routines were designed to print a maximum of 55 lines per page at the normal default number 12 font size.
Many printers have a 55 line default maximum number of printed lines. Either of the four dupesheet formats will meet the



requirements of the Contest Rules, but it is recommended that both the compact or Alpha-Numeric DupeSheet and the
10X DupeSheet be submitted to the Contest Scoring Committee. A contest name must be selected before any of the
following routines are run. Choose one of the existing names from the drop-down box or type in a name of your choice.
Print options 2, 4 and 6 use condensed print. The default size is 8 points, but there is a check box to change the font
size to 6 or 7 points. The remainder of the print options use the Windows default font and font size of 12 points. There is
an option to change this font size to 10 or 11 points. You may have to experiment with your printer to determine the
correct size of printer font to use. The default sizes of 8 for the condensed and 12 for the regular worked fine on my HP
870 printer, but I had to go to the 7 point condensed print for my HP laser printer to get everything on the page in the
condensed mode.

Some printers start printing at the very top of the page and do not leave a top margin. With many printers, this “unprint-
able area” is adjustable from the Printer Properties tab under “Paper”. For those who do not have this feature and their
printer starts printing too close to the top of the page, an option blank line can be printed at the top of every Contest
Printout. You will get the choice when you print the first Contest Printout and this blank line will be inserted on every
Contest Printout you make until you leave the Print Routine.  This blank line option has to be reset with every new
Contest Printing.

1. Print Logs - this prints the log at 50 QSO’s per page. On the last page will be a recap of the one, two and three
point QSO’s. Each page will have a score total for that page. This option also provides for an ASCII file of your
contest log. If you want an ASCII log and dupesheet, run the log routine before doing the dupesheet in Option 6
below.

2. Print Logs Condensed Version - this prints the log in two columns of 70 QSO’s per column or 140 per page.
There will be a recap on the last page. If the band ever opens good and someone makes over 1000 contacts or so,
the condensed log (140/page) will be very useful. In order to get two columns of log info a proportional spaced font
is required. For some very wide calls such as WA0WWW/VE3, the space allowed for the call will not be wide
enough and the balance of the info will wrap to the next line. This should not happen very often and in Version 2.0a
the total QSO’s per column was reduced from 73 to 70 records to allow for an occasional line wrap.

3. Print Dupesheet - Compact Version. This printout prints sorted columns of calls, starting with the U.S. One Call
Area. If one column is not enough, then it will be continued on the next column in a snaking fashion. After the one’s
are finished, there will be a blank space then the “TWO’S” heading and the U.S. Two Call Area will be printed, and
so on to the Tenth Call Area. Then the VE and DX stations will be printed in a sorted column. The sorted list will
appear in the display window and a message will pop-up asking to print log or not. If you answer “NO” then you
can just look at the dupesheet displayed in the window. Later the dupesheet can be printed if you desire. There will
be about 350 calls printed on each page with a recap page on the final page. Note: Hawaii, Alaska and US posses-
sions will be included with the US Call areas in this DupeSheet and the one below.

4. Print Dupesheet - One Call Area/DX per column. This printout will print one call area per column. The disad-
vantage with this version is that if you work a lot of local stations, then that column will be very long and will take
additional pages. The compact version of the dupesheet will have the same data but in a much more compact form.
There will be a recap at the end of the data.

5. Print Dupesheet - 10X Version. This is a printout of only the 10X numbers sorted. There will be 8 columns of 52
numbers for a page maximum of 416 10X numbers. The sorted list will appear in the display window and a message
will pop-up asking to print log or not. If you answer “NO” then you can just look at the dupesheet displayed in the
window. Later the dupesheet can be printed if you desire.



6. Print or Make ASCII File Alpha-Numeric DupeSheet. This will sort and print in 11 snaking columns of 80 calls
per column or 880 per page. Before the printout, a pop-up window will give you the option not to print the
DupeSheet, but to look at the display in the small windows showing the sorted calls. This display can also be seen
after the DupeSheet is printed. This is the most universal DupeSheet format and was added with Version 1.1. You
can also make an ASCII file of this dupesheet. It will have 50 calls per column and 7 columns per page making 350
calls per page. A second page will be started if needed.

7. Print Cover Sheet. This prints a cover sheet with all the necessary info to submit your logs. You may want to copy
the info on this Cover Sheet to the Cover Sheet printed on the back of the 10-10 Newsletter. The log has to be
printed before the Cover Sheet to get the total number of 1 and 2 point QSO’s. Five boxes will pop up for you to
type in the Cover Sheet Info. The date of the first QSO will be displayed in the drop-down Date box and can be
used or changed to the starting date, if you only made QSO’s on the second day of the Contest. Then choose the
Entry Type and make your choice, then move the mouse cursor to the Chapter Assignment box and type in your
local chapter, if any. The Call Area drop-down box has all ten of the U.S. Call Areas for you to choose, or type in
the Country you are operating from. There is an optional Comment message that can be added at the bottom. These
comments are limited to 256 characters and consists of 4 lines with a maximum length of 70 characters. The routine
does not wrap at the end of the lines and the user will have to format his comments to make sure no words are cut
in half. There is a character counter and the other lines need to be started when the counter beeps and shows 70,
140, and 210. If the entry is a club station, then the operators and their calls need to be added in the comment
section.

ASCII: The red ASCII button will prepare an Ascii log and Cover Sheet to be transmitted by email that meets the
specifications of the Contest Scoring Committee importing software. Two Ascii files will be created with the
filenames of MyCall.LOG and MyCall.SUM where “MyCall” refers to your call sign. These two files will be
created in the Win1010 folder and should be attached to an email to the contest scorer. No dupesheet is required in
this case, since the scorer’s software will check for dupes and figure the final score. After hitting the red ASCII
button, the Cover Sheet window will appear. Using the mouse, move to each drop-down box and enter the appro-
priate data. If you have no local chapter then choose the N/A choice. If you choose the Club Entry Class, then a
popup window will remind you to enter each contest operator’s call and 10X in the Comment section. After com-
pleting each box, then hit the “Continue” button. This will bring up the Operator’s info screen where you should
enter the Name and QTH that you exchanged. The Call and 10X is derived from the User_95.dat file, but can be
changed. When finished, hit the “Make Ascii Files” button and both the log and cover sheet will be created in a
second or two. For the 2002 1010 Sprint Contest, these logs will be used as a test and a paper log will also have to
be mailed.

Sound Setup
The program comes with two sample voice files named Sample1.wav and Sample2.wav. Hitting the F5 and F6 keys will
play these two files if the user has not already created his personal contest voice files. The user-created files should be
named F5.wav, F6.wav and so on to F12.wav corresponding to the key that plays the file. It will be left to the user to
decide how to record his voice files. Hitting ESCAPE while the file is playing will stop the sound. The filename appears
in the middle display window and the name will be erased from the display if ESCAPE is hit or something is typed into
the Contest Entry fields.

The F12 key has a special use. It is set up to LOOP the sound file. If the F12.wav file is not present then the
Sample1.wav (short CQ) will be looped as a demo. The purpose of this routine is to call CQ if the band is nearly dead
or you are not getting many responses to your CQ’s. When you record your CQ, leave enough blank space (delay) at
the end for your VOX to drop out and to allow time to check for calls. Then it will repeat again and again until you hit
the ESCAPE key. Note: the Sample1.wav file doesn’t have much blank space at the end since it was recorded short to
conserve hard disk space. You may have to experiment with the blank space to get the desired length of the delay.



Most sound cards come with recording and mixer programs. Even Windows 95 has a Recorder Program for short files
(60 seconds). You can test your files with the Windows 95 Media Player. The user may want to use a sound editing
program to edit out any silent time on the recording, especially at the beginning of the recording. I always like for my
CQ or exchange message to start the instant I hit the F-Keys. There are many shareware and freeware programs
available to edit wav files. Win1010 also has a built in Recorder and Play routine, activated by hitting Ctrl-R or Ctrl-P.
These are described later.

Interface to Transceiver: Since there is an unlimited number of rig and computer combinations, it will be up to the
user to design and build his sound card-to-transceiver interface. Having a phone patch input on your transceiver cer-
tainly makes it easier. I prefer to use headphones, a boom mike and VOX during contest operations. This leaves the
hands free for computer use. I also like to mix the sound output of the sound card with the headphones. If the sound
card is driving a speaker then it has to be very low to prevent feedback. Again you are on your own with this end of this
setup and operation, but the author would like to hear from users who develop a successful and easy-to-use interface.

Sound Recorder: Win1010 also has a built in Sound Recorder which is accessed by hitting the Ctrl-R key. There is a
drop-down box that lists the files that can be recorded. Clicking on one of the files will erase the file if it already exists
and will open the file for recording. Clicking on the Record button will begin the recording session and will stop when
the Stop key is clicked. To hear the recorded file, click on Rewind and then hit Play. If it is OK then you can hit Save, if
not, reselect the file name from the drop-down box and record again. Note: this routine cannot be used to play the
existing recordings. Instead use the Sound Player by hitting the Ctrl-P key.

Sound Player: Hitting the Ctrl-P key will pop-up the Sound Player with a drop-down box displaying all the wav sound
files. This routine will also let you delete a sound file.

Recording using the Windows 95/98 Sound Recorder. You have a 3 sound quality choices: CD, Radio or Tele-
phone. I recorded the two Samples using the PCM Radio Quality. The better the quality, the larger the sound WAV
files. After you record your messages you can go to Properties Under File and convert to a different Audio Format. This
recorder has a maximum recording length of 60 seconds, which should be adequate for 1010 Contesting.

Off-the-Air Recordings.   By hitting Ctrl-1 through Ctrl-0 you can record ten off-the-air recordings. Only your hard
drive space will limit the length of the recorded file. End the recording by hitting the Escape Key. There will be a red
label in the middle of the screen to let you know when the recorder is on. A one minute recording will take about 1.3MB
of hard disk space. If the sound file already exists then a warning message will pop up and ask if you want to overwrite
the existing file. If not, you will need to choose another file. You can see a list of the sound files already recorded by
going to the View Menu Item and choosing “Recorded Files”.

Continuous Loop Recording. Hitting the F3 key will activate this routine. It will record the receiver audio until the F3
key is hit again. When activated, there will be a red “REC” button to appear in the lower portion of the screen indicating
REC-1, REC-2 or REC-3 depending on the current loop file being recorded. This is to remind you that the continuous
recording is in process. There are 3 loop sound files named L1.WAV, L2.WAV and L3.WAV, each one’s length being in
multiplies of 30 seconds, as determined by a value in the configuration file. The default is 90 seconds for each file, but
can be changed in the Misc Options Menu. When the F3 key is hit, L1 records for 90 seconds, then L2 records for 90
seconds, then L3 records, and then L1 is erased and records again, and so on. Therefore, whenever the F3 key is hit
again to stop the recording there will be two complete loop files and a partial depending at which part of the 90 seconds
F3 is hit. This means that the last 180 to 270 seconds of received audio can be replayed by hitting the Ctrl-P key and
choosing the L1, L2 or L3 files. Increasing the default file length to 3 minutes would mean that the last 6 to 9 minutes of
audio could be replayed if you missed some info or wanted to listen to a transmission again. Although this routine works
in the background, on some computers it may slow certain operations. Each minute of recorded audio takes about



1.3MB hard drive space. When the F3 key is hit to stop the recording, a message will appear in the middle message
window indicating the last loop file that was recorded. This will give you a clue as to which of the L1, L2, or L3 files to
listen to first using the Sound Play activated by hitting Ctrl-P.

There is an option on the Options Contest Setup menu to disable the beep whenever a dupe is worked. This will
prevent this beep from triggering your VOX.

http://www.muenster.de/~welp/sb.htm is a web site that has a lot of soundboard software and misc info posted.

Contest Database Utilities
The Contest Database that is packaged with the Win1010 program has the name DB95.DAT. Updates of this file will
always be posted on the HDS web site. If you modify this Default Contest Database by adding your personal logs, then
it is advised that you rename the database to something that starts with DB and has the extension “DAT” such as
DB_JIM.DAT. Then you can choose your customized database as the Default Contest Database in the Options Menu.
This would prevent overwriting your custom database if you downloaded an update from the HDS web site. Some of
the routines below automatically make a backup copy on the hard drive, but it is highly recommended that before you
do any sorting, removing dupes, etc., that you make another copy of the database in question on a floppy disk as a
precaution.

Add Contest Log To Database. This will allow you to add a log of your choice from the pop-up “Open Existing File”
window to the database that is chosen as your Default Contest Database. Should you want to add the log to another
Database file, then go to the Options Menu first and choose another default contest database. New Calls added with be
displayed in the upper left display screen and the total number displayed at the end of the displayed list.

Add New Call To Database. This routine will pop-up a window to add a new callsign to the current default contest
database.

Convert Old DOS Database.BIG to Windows 95/98 Format. The new database format adds several digits to the
name and QTH fields. The old DOS database only used two digits for the QTH field. This caused DX country names to
be cut-off with only two letters. This conversion routine expands the DX country name to the full name.

Create New Database From Log. This will create a new database using the contest file chosen from the pop-up
“Open Existing File” window. Another pop-up “Open New File” window will appear displaying the existing database
names. Choose a name that does not exist.

Edit Database. When displaying the Database (by clicking on the red DB button), just double-click on the record that
you want to edit. A pop-up edit window will pop-up. After editing, the entire contest database file is re-read into
memory.

Find Database Dupes. Before running this routine you should run the Sort DB routine. The Find Dupes routine
depends on dupes being adjacent records. This routine only displays the duplicate calls on the screen. To remove the
dupes run the “Remove Dupes From Database” routine. There is also an option to find all 10X dupes.

Merge Two Databases. There are options that will allow you to merge one database into another database or to
combine two databases and create a new combined one. There is a pop-up screen for this routine. Choose from the
drop-down boxes the name of each database. The default routine is to merge #1 into #2, however, if you want to create
a new database #3, click on the “Create New Database” check box and type in the name of the new database using
this format DBxxxxxx.DAT. The “xxxxxx” is what you will use to create a new name. During this routine the #2 data-
base is copied to the new filename and #1 is then merged into #3, thus creating the new contest database. To view this



new database, you can go to the Options Menu and choose the new database as your Default Contest Database and
then choose the option to read into memory. Then display by hitting the red DB button.

Remove Dupes From Database. The Sort Database routine has to be run before this routine is run. This routine
requires a sorted database and depends on dupe calls being adjacent each other. The default Contest Database if
copied to a backup file named DB95.BAK, should you need it. There is a maximum of 300 calls that can be removed in
one operation. If there are more than 300 calls, then you will need to rerun this routine.

Remove Silent Keys/Non-10X Records From Database. This routine checks the 10X database (1010.TXT) and if
the 10X number in the 10X database belongs to a Silent Key, then the callsign for this record is changed to “DELETE”
and can be deleted later by running the “Remove Dupes From Database” routine. An up-to-date 10X database should
be used for best results. This menu item will also allow you to remove all records with a 10X number of zero.

Update Database by 10X Database. This reads the 10X in the default Contest Database and then checks the call for
the 10X number. If it is different from the database, then the database is updated with the new call. Updates are re-
ceived monthly reflecting vanity calls and call area moves. Again, the 10X database should be current for best results.
This routine is very fast. For this to be successful it requires the 10X member to notify the 1010 Records Keeper of the
new callsign. In many cases, new vanity calls in the database will not have been reported to the Records Keeper and the
correct call will be changed back to the old callsign. A much better method to update vanity callsigns is the Update
below by PrevCall Database. This database is updated weekly by K4HAV and posted on the FCC Web page

Update Database For New 10X Numbers. This checks the 10X database for each callsign in the default Contest
Database that has no 10X number. If that call is found then its zero 10X number is replaced with the newly issued 10X
number. Many times you will work a station in a contest that has no 10X number at the time, but gets one later. This
routine will update the Contest Database in those cases.

Update Database By PrevCall Database. The FCC posts a weekly file with all call changes. I have been compiling
a databases of these previous calls and new calls for several years. Many 1010ers sometimes delay notifying the 1010
Recordkeeper of call changes and this previous call database can be used to update the database with the very latest
call changes. This file is considered a FCC file and should be in the FCC Path. It can be downloaded from a link on the
HDS web site. This is a slow routine because every call in the Contest Database has to be compared to every call in the
PrevCall Database. Depending on the size of the Contest Database this operation could take 3 to 5 hours. At the
present time there are over 143,700 calls in the PrevCall Database. On a recent update on an AMD 333 Mhz CPU,
this routine took just over three hours, but would be faster on the current entry level computer.

Other Utility Programs
Backup Log. This will make a backup of the Contest Log to a floppy disk in Drive A. Typing SAVEA as the call in the
Call field will also trigger a backup as well as hitting the Ctrl-B key. There is also an automatic backup after “X” number
of QSO’s. This can be setup on the Options Misc Menu.

Check Log. This routine should be run before printing logs and dupesheet. For this to be accurate, the 1010.TXT file
should be current. This routine checks each contact with a 10X number and compares the call in the 10X database with
the call in the log. If it is not the same then a display will list the QSO number and callsigns. If the calls are different, it
may mean that a mistake was made copying the info or that the station has got a new vanity call and it has not been
updated in the 10X database yet. Running this routine is optional, but it will point out potential errors in the log. Another
possibility is that an error exists in the 10X database. You should not make the assumption that all the databases are
100% accurate.



Duplicate Log. This routine is for use with two-station logging. After the contest is over, it will duplicate the first log and
add a “2” to the file name. For example, if the contest log is named FALL98.Q95, then the duplicated filename will be
FALL982.Q95.  The purpose of this duplicate log is not having to hit the F4 key to file the QSO in the second log. This
method assumes that most of the time both QSO’s will be made. If several are not completed, then jot down their calls
and when the second log is duplicated from the 1st log, just delete these missed QSO’s. This method would probably
be best for the 2nd station being the Club call, but could also be used in an OM/XYL team operation.

Convert Old DOS Logs to Windows 95/98 Format. A good use of this routine would be to convert your old logs if
you wanted to import them into a current Windows 95/98 format Contest Database. Or you may just want to display
the old log in the new contest window or perhaps want to sort one of the columns. The converted contest file will have
the same name but a different extension. All the Win1010 contest files end with the Q95 extension. The converted logs
will not have the 3 point scoring for the DX stations.

Export/Import Logs. This routine has several different output formats.

1. Comma Delimited ASCII File. Exports all the log info in a comma delimited file named Export1.DAT. If the
file already exists it will be overwritten; therefore, if you should want the existing file, it should be renamed.

2. Comma Delimited ASCII File w/VP Only. Exports all log info only for stations with a VP number with file
name of Export2.DAT.

3. Fixed Length ASCII file. Exports all the log info in a fixed length file of 143 columns named Export3.DAT. If
the file already exists it will be overwritten.

4. Fixed Length ASCII file. Exports only records with VP Numbers and adds Call and 10X with filename
Export4.DAT.

5. Callsign Only. Exports only the callsigns to a file named Export5.DAT. If the file already exists it will be
overwritten.

6. ADIF Contest Format Export. This is a standardized export format developed by a group of contest and
logging programmers listed at the http://www.hosenose.com/adif/ website. The following software supports
ADIF import: LOGCONV,  SWISSLOG, ProLog, NA Contesting, Super Duper contesting, Log-EQF,
IcomLog, KenLog, EasiLOG, LogWindows, HyperLog, CT, BV QSL mgmt and printing, FT Manager, Lux
Log, XMLog, LOGic, DX4WIN, WJ2O Master QSO, and RTTY by WF1B. Therefore, Win1010 contest
records can be imported into any of the above programs. The ADIF file created will have the same file name,
but with the ADI extension. It can be read with any DOS file reader, such as NotePad, Word Pad or the DOS
Edit Command.

7. Export New 10X Numbers to Win1010CH County Hunter - This routine will export all contacts with a new
10X number into the Win1010CH County Hunter Program. It will also check the County and if it is a new
County, then it will be marked “New County”. For Export Options 7–9, the CH95.DAT and COINDEX.DAT
files are checked for existence. Logs cannot be exported to a non-existent CH95.DAT File A pop-up window
will display all the calls exported and a print routine will be available if desired. For calls with prefixes that can
be used for more than one country, a “Multiple Country Selection” window will pop up. The country that was
chosen in the Contest Program will be displayed on the Country Selection screen.

8. Export New Counties to Win1010CH County Hunter - This routine will export all contacts with 10X
numbers that is a new County. If the 10X has already been entered then the BAR indicator will be filed as “U”
indicating that the 10X has already been entered. This would be the case if you worked a Mobile station in



several different counties. The normal procedure would be to run Option #7 first and then Option #8. These
two options will also enter the VP number if in the log. A pop-up window will display all the calls exported and a
print routine will be available if desired.

9. Export New VP to Win1010CH County Hunter - This routine checks the 10X record in the County Hunter
and if the record does not have a VP number then it will be exported. Therefore, this routine must be run after
the Export New 10X Number routine has been run.

A. Export New CW Contacts to Win1010CH County Hunter - The normal Export New 10X numbers will
export all new 10X, but if the 10X is already in the CH as a SSB QSO, then the CW contact will not be
exported.  This routine checks the 10X numbers in the County Hunter file and if already worked but not as a
CW contact, then this record will be exported. Therefore, before running this option, options 7, 8 and 9 above
should be run first, otherwise new CW 10X numbers would not be exported, but only existing non-CW 10X
numbers. This routine will check the County Index file and if it is a new county, then the NewCo indicator will
be set to “Y”. Likewise, the VP will be checked and if it is a new VP, the VPBAR will be set to “N” meaning
that it has not been used. If the VP has already been entered in a previous record, then the VPBAR indicator
will be set to “U” — meaning Unusable. The CWBAR indicator will be set to “N” for all CW contacts trans-
ferred. If later you transfer new counties and it happened to be the same CW station, the CWBAR will still be
set to “N”. This will require that the Update CW Indicators routine be run as indicated below.

B Export New Mobile to Win1010CH County Hunter - The normal Export New 10X numbers will export all
new 10X that is a mobile, but if the 10X is already in the CH, then the mobile contact will not be exported.  This
routine checks the 10X numbers in the County Hunter file and if already worked but not as a mobile, then this
record will be exported. Therefore, before running this option, options 7, 8 and 9 above should be run first,
otherwise new Mobile 10X numbers would not be exported, but only existing non-Mobile 10X numbers. This
routine will check the County Index file and if it is a new county, then the NewCo indicator will be set to “Y”.
Likewise, the VP will be checked and if it is a new VP, the VPBAR will be set to “N” meaning that it has not
been used. If the VP has already been entered in a previous record, then the VPBAR indicator will be set to
“U”. The MobileBAR indicator will be set to “N” for all mobiles transferred. If later you transfer new counties
and it happened to be the same mobile, the MobileBAR will still be set to “N”. This will require that the Update
Mobile Indicators routine be run as indicated below.

ReCreate Index and Indicators Update Routines: The above contest log export routines to the County
Hunter, do not update the DX and Prefix Indexes or the NewCtry, CWBAR and MobileBAR indictors. The
County Index is updated as well as the NewCounty, 10X BAR and VPBAR indicators. It would be very
difficult to write the code to compare all indicators and update everything on the fly. Therefore, the above
mentioned ReCreate Index and Indicator Update routines MUST be run to get the indicators in sync. The VP
and 10X Update Indicator routine can also be run if desired. As always, you should make a backup of the
CH95.DAT file before exporting contest logs or running the update index and indicator routines.

C. ADIF Contest Format Import. This will import into Win1010 another logging program’s log provided it is in
the ADIF format. This routine will import the time and date, call, name, QTH, State, county and 10X number.
The new contest file will be named ADIF.Q95 and will overwrite any existing ADIF.Q95 file. At the present
time the ADIF specifications do not have a separate field for the VP number. No QSO point values will be
imported. The ADIF specifications now has a separate ten_ten field and this routine is written to support the
new ten_ten specification. If your ADIF export program is not current, then it may put the 10X in a misc com-
ment area. If that is the case then the imported 10X number will not be correct and you will need to either
choose the option “not to import 10X numbers” or contact the program’s author that you are trying to ADIF
export and get the latest version that supports the ten_ten ADIF specification. The State must be in the State
field. Some logging programs put the State in the QTH field and thus, will not be imported. Names longer than



19 digits will not be imported and names from 15 to 19 digits will be cutoff at 15 digits.

If the ADIF file to be imported contains the VE_PROV field, then the Canadian Province will be imported,
otherwise ”Canada” will be used for the QTH.  If the State is not used for U.S. stations (or is missing for a
record), then USA will be used for the QTH. For the County to be imported, the spelling must be the same.
Non-matches are displayed in a message box and can be written down and entered later by editing the record
and using the “Get County Number” from the Edit routine. A “County Not Found” file (Co_NotFd.TXT) will
also be created and will contain this list of non-matched counties and calls, which can also be used for later
editing. Remember that Dade County, Florida has been changed.

An error routine detects any import errors and displays the Call and Record Number. Write these down and
edit later. At any error, an ABORT option will be offered to exit the import routine if desired.

D. Export Contest Log to Daily Log. This will export the contest log loaded into memory into the Daily Log.
The default RST’s of 59 or 599 will be imported for each call. This routine does not check for existing 10X or
calls, it imports everything without checking for dupes.

NOTE: Before exporting into the County Hunter or Daily Log you have to check the proper QSO MODE - CW,
SSB, AM, FM, or RTTY.

ASCII LOGS: A recent addition in Version 1.2 is the option to print a log and dupesheet in ASCII format. You may
want to send a copy of your log to your chapter via email. This option is on the Contest Print Menu and uses Option 1
for the log and Option 6 for the dupesheet. At the beginning of each print option you will be given the choice of the
ASCII log or to proceed to the printout. Version 2.2 introduces a new ASCII log and cover sheet for submission via
email to the Contest Scoring Committee. This is in the trial stage so it may or may not become an accepted method of
submitting logs. The routine is activated by hitting the red “ASCII” button on the Contest Print Menu.

Remove Deleted QSO’s From Log. When a QSO is deleted in the Edit Mode, the call sign is replaced with “DE-
LETED”. Running this routine will remove these Deleted records and renumber the Contest File. A window will pop-up
with an option to make a backup of the QSO file to a floppy disk. During this routine, each QSO is checked and if not
“Deleted” then it is written to a new file named Remove.dup. At the end of the routine the Contest File is deleted and the
Remove.dup file renamed back to the Contest File. Then the new Contest File is read into memory and the QSO Log
Window can be updated by hitting the red Refresh (REF) button.

Find Number of Silent Keys in 10X Database. This routine will search the 10X database (1010.TXT) and find the
number of Silent Keys. To be accurate the 1010.TXT file should be current. This routine was added to answer a recent
question posted on the 1010 Mail List.

Pop-up Calculator. A small calculator is available by hitting the Control-A keys.

Contest Program View Menu
1. Notes. This option will give a directory listing of all the notes that were written during the contest. The note will be

displayed by “opening” the note file name.

2. Contest & County Hunter Revision File:  This is the combined revisions by version number and date.

3. Graph of QSO/Hour. This will display a rate graph showing contacts per hour for each day. The first day will be
red bars and the second day will be green bars. This display is very impressive when viewed after the contest is
over. Or it can be viewed the second day to see what was done the first day. Exit this display by clicking the “X” in



the upper right hand corner. This display is full screen by default, but can be resized if desired. The screen title will
have the total number of QSO’s and each day’s total. The display is valid only for two consecutive dates as would
be the case in a contest.

4. Graph of WAS. This will display a graph of all 50 States and the number of QSO’s made in each state. The
number of QSO’s and a list of stations in that state can also be displayed using the red WAS button.

5. Log Full Screen. This option will display the QSO Log in a full-screen window. Each column can be sorted by
clicking on the column header and a QSO can be edited by double-clicking on the record.

6. Log Full Screen - DX Calls Only This option will display the QSO Log in a full-screen window, displaying only
the stations with a DX Call.

7. Log Full Screen - Mobile Stations Only This option will display the QSO Log in a full-screen window, displaying
only the Mobile Stations with “/M” at the end of their call.

8. Log Full Screen - VP Stations Only This option will display the QSO Log in a full-screen window, displaying only
the Stations with a VP number.

9. Log Full Screen + Print Labels. This option will display the QSO Log in an almost full-screen window. The
routine allows the user to tag certain QSO’s and print either QSL Labels and/or Address Labels. See the Print
Labels after this View Menu section.

10. 2nd Log Full Screen. This option will display the 2nd QSO Log in the case of a Club Station or an OM/XYL
team operation.

12. Recorded Files. This option will give a list of all the WAV files in the Win1010 directory. This same list can also be
found by hitting Ctrl-P for the Sound Player Routine. The files can be played in the Player routine, but not in the
View option.

Print Labels
This routine is accessed on the View Menu Selection #5. The main purpose of this routine is to print selected Address
labels, but also includes a QSL label printer. There will probably be little interest in printing QSL Labels; therefore, not
much time was devoted to the QSL routine. The Address Label routine only uses the FCC Database as its source of
data. There is a separate help window that can be accessed from the routine to refresh your memory on the various
buttons and options. There are separate print routines for the Dot Matrix and Inkjet/Laser type printers. Some of the
printer properties can be changed to alter the print output. When printing in Windows, the spacing between lines is
determined by the font size; therefore, 3 font sizes are selectable to adjust to the fixed label spacing. Test printouts
should be done on plain paper before using the blank label page.

Label Style: Two types of labels can be used.The Inkjet Style prints either three columns of 10 labels making a page
total of 30 labels of 2 5/8 x 1 size or 20 labels in two columns of 4 x 1 size.. One page is printed at a time. The Dot
Matrix Style will print the 30 labels on a single column type fan-fold label. When you hit the Print button, you will have a
choice of either 2 or 3 columns. You MUST have set up your tabs before printing. Suggested tabs are 0,67 for two
columns and 0. 44. 88 for 3 columns. You should test using plain paper before using a label sheet to insure that the tabs
are set correctly.



Selection Mode: Mode One allows you to select one call at a time. Mode Two allows you to select one at a time if
you hold the Control Key down, or you can hold the Shift Key down and click on one record, then skip down several
records and click on that one and all in-between. Mode Two is also good for de-selecting the entire list selected by just
clicking on a record. All the others will be cleared.

Font Size: On the HP Inkjet printer the 10.5 point font size produces the best spacing on the label printout. This value
can be changed by clicking on the desired font size.

Top Spacing: Most labels on the inkjet type label page start about one-half inch from the top. This Top Spacing value
inserts blank lines to start the labels at the correct position. On the HP Inkjet, 3 lines start the labels at the correct
position.

TABS: This is only used for the Inkjet Print Style Address labels and adjusts the starting position for the two and three
columns printouts. On the HP Inkjet 895 the tab setting of 0, 44 and 88 starts at the correct position for the 3 column
labels, but can be adjusted for other printers. Tab #1 is also used in printing the QSL Labels.

Display: This will display the tagged calls and will let you know when you have the maximum of 30 tagged. If you have
over 30, then only the first 30 will print. The FCC Database only has U.S. and VE calls and therefore will not print DX
Address labels.

QSL: This will activate the QSL Label Printer and will print the first line “Confirming QSO with K4HAV”, then skips a
line and then the 3rd line will be “26 JUN 1998  03:44  10M  SSB  59”. Before the QSL labels are printed you have
the option of “SSB 59” or CW 599”. As stated before, not much time was devoted to this routine, and it has certain
limitations. In the Dot Matrix Mode, you can print 20 QSL labels on a one-column fan-fold label, but in the Inkjet mode
only one column of 10 can be printed. To print the next 10 you will need to reverse the label page and run back through
for the next ten on the third column. The left hand tab can be set by hitting the TABS button and setting Tab #1.

Print: The Print button will print the Address labels. Use the QSL button to print the QSL labels. The Print button will
give you an option to use the 2 column 4 x 1 labels or 3 column 2 5/8 x 1 labels.  All 20/30 sets of address info is read
from the FCC Database and stored in an array before the printing starts; therefore, you will experience a “searching
time” of 2 to 3 minutes while the addresses are being searched. For the three column printing, if the length of the call and
name is longer than the label will fit, then the call will not be used.

Help: Displays some basic info about the Label Printer.

Help Topics
1. F Keys. A display of the various Function Keys. This file (Help_F.TXT) can be edited to give a title to your Sound

Files if desired. A second set of F Keys are used in the County Hunter Program.

2. Alt Keys. A display of the various Alt-Combination Keys. These keys can be used instead of the mouse when
running any of the routines at the bottom of the screen indicated by the red buttons.

3. Control Keys. A display of the various Ctrl-Combination Keys.

4. Buttons. A display of the red/blue buttons at the bottom of the screen. These routines can also be accessed by
using the Alt-Combination Keys in Help Topic 2 above. The underlined letter on the buttons indicate the Combina-
tion Key that is required to activate that routine.



5. Beacons. A display of the Beacon List downloaded from the 1010 International Net’s web site. The file name is
Help_B.TXT and can be edited to add more beacons. There is a capacity of 150 beacons.

6. DXCC List. A display of the DXCC list that was downloaded from the ARRL web site. The file name is
Help_DX.TXT.

7. Prefix by Country. A display of prefixes sorted by country. At the end of the record is the ARRL DXCC number.
This number is used in the ADIF Contest Export Routine. This file contains just over 850 prefixes and has a capac-
ity of 1200. To add a new prefix you would need to use a DOS editor, Word Pad or NotePad. Use the same
format as other prefixes in the same country. The file name is CTY_AZ95.TXT. Before adding new prefixes it
would be a good idea to make a backup copy. For the automatic DX Country Recognition Routine to work, the
prefix must be in the file. A prefix can also be a callsign up to 6 digits that is an exception to the prefix, such as
KG4DX who is in Guantanamo Bay. Normally a call such as KG4AA would not trigger Guantanamo Bay because
it would be assumed to be in the USA.  Entering KG4DX would enter the QTH as Guantanamo Bay. Other excep-
tions include KC6GZ which is in Micronesia whereas most KC6’s would be in California

8. Country by Prefix. A display of prefixes sorted by prefix.

9. Misc. A display of misc info. The file name is Help_MIS.TXT and can be edited if desired.

A. User_1. There are four user files available, each with a 50 line capacity. Use these for anything you desire, such as,
a list of Counties Needed, Schedules, results of previous contests, etc. The file names are Help_U1.TXT,
Help_U2.TXT, etc. You can use NotePad to create or edit these files. The program reads the contents of these files
on start-up, so create the new files before running the program.

B. User_2. User files

C. User_3. User files

D. User_4. User files

Two Log Setup
This was designed for the operator that is operating his station and also giving out numbers for the Club Station. It can
also be used by an OM/XYL team. To start a Two Log Operation, simply hit the F4 Key to file the first QSO (and
following QSO’s). It will be saved to a file with the same name, but with a “2” appended to the filename. A file named
File2Nr.DAT is created when the first QSO is transferred to the 2nd Log. The purpose of this file is to file the QSO
Number of the QSO that was put in the 2nd Log. This file is only used for the Full Page Display of the 2nd Log under
the VIEW Menu. It is possible for the band to change and the second QSO may not get confirmed; therefore, not being
filed. Whenever a new Contest Filename is created the old File2Nr.DAT file is erased. Should a new Contest Filename
be created then the old 2nd file could not be displayed full screen, but could be read into the program as a Contest File
from the “Open Existing Contest” Menu.

To print the logs of the second log, you will need to open it as an existing contest. The name and call of the registered
station will be printed on the logs and can be manually over-written to indicate the Club station operated by the regis-
tered user or the XYL of the registered owner. If you should want a customized UserID file for your club or your XYL
then please advise by email and the file will be emailed to you at no cost or mailed on a floppy for a small fee to cover
expenses. If the second UserID file which will be named User_95a.Dat is in the Win1010 directory, then you will get a
pop-up message asking which UserID file to use when printing the log.

The program will recognize that a Two Log Operation is in progress if you reopen the existing log and all you have to do



to file the next QSO to the 2nd Log is to hit the F4 key.

This two log routine was designed to run only the 1st log as the main log and copy the desired QSO’s to the 2nd log.
However, in the case of the second operator being gone and then comes back and hears a station that the 1st operator
worked during their absence. The 2nd station can work this station by opening the number “2” contest log as an existing
contest log. Then when finished, reload the number 1 log and continue. If this procedure is followed, an error will be
generated when displaying the 2nd log full screen, but the program will not crash. The station that was just worked and
filed using the 2nd log as an existing log will not show up on the display, but will be in the log for printing the logs and
dupesheet. If you are using the 2nd log as an existing log, then do not hit the F4 key to file a QSO back into the number
1 log.

Alternative Method: Some stations reported during their first use of the F4 Key to log to the second log that on
occasion they would forget to hit the F4 key. Another approach would be NOT to hit the F4 key at all, in fact, just
forget about the 2nd log until the contest is over. Then go to the Contest Utility Menu and choose the Duplicate Log
option to copy the contest log. The name will be the same with a “2” appended to the end of the file name. This method
assumes that most of the time both QSO’s will be made. If several are not completed, then jot down their calls and
when the second log is duplicated from the 1st log, just delete these missed QSO’s. This method would probably be
best for the 2nd station being the Club call. If the XYL made the 2nd exchange, then it would be more natural for the
XYL to hit the F4 key as the final act of the QSO.

Updates
Updates will be posted on the Win1010 download page at http://hds.net/win1010dl.htm. The 1010.TXT file is updated
monthly and the VP.DAT file is updated several times a month. The FCC Database is updated weekly and posted on
Sunday night or Monday depending when the FCC posts the data to their web site. The Default Contest Database -
db95.dat is updated before every Phone Contest with newly received 10X numbers for those contacts during the
previous contest that had no 10X number. Also the db95.dat database is updated with new vanity calls.  Program
updates will also be posted on this page. These program updates will be the main win1010.exe file and other files that
have been changed will need to be copied to the Win1010 directory replacing the existing Win1010.exe file. From time
to time the Help Files (Manual) will also be updated and posted as a file and also the web page displaying the Help File
will be updated. For those not on the Internet or without friends on the Internet, updates will be furnished by U.S. Mail
for $10 which will inclde a CD with the latest Win1010 Program and FCC databases. Just the updated Win1010
program file and other databases that are updated will be available for $1.00 for a floppy disk ($2.00 for DX).

Update Program
A new Update Program was added to Version 2.3. This program is activated by hitting the “file” button in the upper left
hand part of the screen and hit the “Run Win1010 - FCC Update Program.” The use of this program is optional, but
was designed for those who have a problem unzipping an update into the proper folder or not being able to find the
update file once they have downloaded it. There is a Help file that can be accessed from the Update Program. This
program will find the download and unzip it into the correct location.

Supporting Files
These are files that, if installed, will add features to the Win1010 Program. These files can be installed either in the
Win1010 Directory or the path set up in the Options Path Menu. There is a link on the Win1010 download page to
download these files, if desired.

FCC - These files consist of the Addr_xx.DAT address files, the Prev_xx.DAT, and the Zip Code files. These files are
used in the K4HAV FCC Search Program, but can also be accessed from within Win1010. The Prev_xx.DAT Previous
Call Database is also used to find new calls for stations that have upgraded or received vanity calls. A new addition to



Version 1.0d is an Index File search routine. If hard drive space (7.3MB) is available then an increase of search speed
up to 8 times can be achieved. These Index files must be of the same date as the FCC Address files and will be posted
at the same site as the FCC files. A link to the FCC Index files is given on the Win1010 Download Web Page. The
Index files will be used if present and at the bottom of the display will be the note “Using FCC Index Mode.”  NOTE:
In September of 1999, the FCC revised the format of the Amateur Radio database and the DOS based FCC Conver-
sion program was rewritten as a 32 bit Windows 95/98 program. The format of the converted FCC database has been
changed slightly and the Win1010 FCC routine has been modified to read both formats – whichever one is present. The
new format of the DOB file is a single file named CallDOB.DAT and the Previous Call Database is now also a single file
named PrevCall.DAT. The Win1010 FCC program will use whichever is present. If both are present then the new
format will be used.

Date of Birth - These files are named DOB_xx.TXT and can be downloaded from a link on the Win1010 download
page. This is the last DOB file that the FCC published and was current to July 1997. This file will not be updated
because the FCC changed their policy about including the DOB with the FCC database. This file was updated again in
late November 1998 with the new vanity calls and will be updated several months or so to include the updated calls.
The revised FCC format now uses a combined file named CallDOB.DAT. However, Win1010 will use either format in
the FCC folder. This file is downloaded as DOB.ZIP and was updated in October 1999.

County Hunter Files - The CH95.DAT and CoIndex.DAT can be used by the Win1010 Program to determine if a
station worked is a new 10X, new VP or a new County for you. If so, a red flag will appear at the top of the field that is
a new item that is not already in the CH files.

System Info
On the Help Menu tab is the “About Win1010” and on this display is an option to obtain the “System Info”. This has all
kinds of info about your computer including amount of memory, free resources, programs that are running, number of
hours your computer has been on, version of Windows, IRQ info, I/O info, DMA info and just about everything about
your computer that you ever wanted to know.

Uninstalling Win1010
If you are going to reinstall the Win1010 program, you must uninstall it first. Go to the Control Panel and choose the
Remove Programs icon. This will only remove the files that were installed during the setup routine. To completely
remove the program you must go to the Win1010 directory and manually erase the files created after the installation.
However, if you want to use your existing data then the only file that you might need to manually delele is the
Win1010.exe file. If you try to delete and get the “file in use” error, then you will need to go back into Windows and hit
the Control-Alt-Delete keys to display the active programs and manually close the Win1010.exe program. On some of
the early versions of Windows 95, the Win1010.exe program was not fully terminated upon EXIT. On later versions and
Windows 98, the program makes a clean exit.

Misc Info
The DOS-Based 1010 Contest Program had a small program to find calls from 10X, and 10X from calls. Included in
the Setup package is a program named 10X.EXE.  It is a small Windows 95 program that loads fast and can be used
for fast lookups. Also the 1010 and VP numbers can be displayed in a range (a feature not available in Win1010). You
can manually create a shortcut to this program or run from the START – RUN box after typing in the path. The Setup in
Version 1.8 now will give you an option to let the Setup add the icon.

The 10X Cat Icon (XX_CAT.ICO) is included in the setup files in case you want to use this icon on your desktop. To
change the icon, right click on the existing icon, choose Properties, then Shortcut and then click Change Icon.



Whenever you hit the red DB button to display the Default Database, the time required to load the database into the
display window will be shown at the end of the display. On my AMD K6 233 with 64MB RAM it takes 7 seconds. On
a Cyrix P166+ with 64MB RAM it takes 11 seconds and on a 486DX120 with 16MB RAM it takes 42 seconds. On
an Athlon 600 Mhz with 192MB of Ram it takes 4 seconds.

In the 10X Search Routine, the unassigned 10X numbers in the 1010.TXT database has for its call – the 10X number.
For example at the present time if you search for 10X of 74999 then the call that you will get will be 74999. The
1010.TXT file has recently been increased in size to handle 75,000 10X numbers. The original 1010.TXT file had
70,000 records. Either will work with the Win1010 program, but the current version should be downloaded and used.

Several stations have reported failure to register the Resize OCX – these stations were using the very first version of
Windows 950a. This OCX requires a newer MFC40.DLL file that came with the original Windows 95. See this web
page about problems registering the Resize32.ocx http://www.lyoung.com/faq/faq1.htm  Check the date on your
computer that runs win1010 for the MFC40.DLL file and if it is newer than the one that does not run, then updating that
file should work. On my Windows 95 computer the file is 922K and dated 2/28/96
and on my Windows 98 it is 924K and dated 12/8/97. Also see http://www.lyoung.com/faq/faq18.htm Win1010 uses
the version 2.0 of the ReSize Control. To manually register a DLL, you would go to the START button and click on
RUN and enter  REGSVR32.EXE  MFC40.DLL and click OK. A message should appear saying that the control
was successfully registered. Recently added to the Misc Folder on the Win1010 CD starting with version 1.5c is a file
named Resize.EXE which when run will install the newest Resize.OCX file. This also has been sucessful in registering
the Resize OCX file for users using the very first copy of Windows 95.

Installing the Win1010 Program on a New Computer
Just copying the Win1010 folder from an old computer to a new computer will not work. The Win1010 full Setup
program must be used to install the program on a new computer. This full Setup program will also install the supporting
Windows DLL and OCX files. You will need to copy your user_95.dat file from your original CD or from a backup –
however, this file should be included in any backups that you make.  You can install the Win1010 program from your
original CD if it is version 1.5b or later. Versions earlier than this did not have the Y2K updated DLL and OCX files. If
you have an older version, then you should download the full setup program from the HDS web page. This file is about
6MB in size and is a self-extracting EXE file.

There are several methods to transfer an existing Win1010 program to a new computer:

The ideal method would be to copy your entire Win1010 folder with all the sub-folders to a ZIP Disk. Then after you
install the full Win1010 Setup program on the new computer, just copy the ZIP full backup on top of the new install. If
this method is used, then the version copied from the old computer will now be the version on the new computer.  If you
had version 1.8 on your old computer and installed version 2.0 on the new computer and then installed your complete
backup, then you would end up with version 1.8 on the new computer.

Another method would be to connect the two computers with the Windows Direct Connection and copy the old
win1010 folder on top of the new install. A network connection could also be used to transfer the data files from the old
computer.

Another method would be to make a floppy backup using the Backup Menu in the Certificate Chaser. This will prompt
you for additional floppies if the first one gets full. After you install the new Setup on the new computer, then go to the
Certificate Chaser and run the Backup Menu and choose the Restore from Floppy option.



Another good method would be to burn a CD with the complete Win1010 folder from the old computer and use this
CD to copy the old files on top of a new install.

After you are finished, the program should run and recognize all your old files. If the program starts in the DEMO mode,
then this means that your user_95.dat file was not installed. You will find this on your old computer or on your original
Win1010 Program CD in the root directory and also in the Backup directory.


